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Conformity / Supplemental Information:
The product complies with the requirements of the Low Voltage Directive 73/23/EEC and the EMC Directive 89/336/EEC 
(including 93/68/EEC) and carries the CE Marking accordingly. Contact the manufacturer for more information.

Limited Lifetime Warranty
Alicat Scientific, Inc. warrants to the original purchaser (hereinafter referred to as “Buyer”) that instruments manufactured 
by Alicat Scientific (hereinafter referred to as “Product”) shall be free from defects in materials and workmanship for the life 
of the Products.
Under this warranty, the Product will be repaired or replaced at manufacturer’s option, without charge for parts or labor when 
the Product is carried or shipped prepaid to the factory together with proof of purchase.
The foregoing shall constitute the exclusive and sole remedy in lieu of other remedies of the Buyer for any breach by Alicat 
Scientific of this warranty to the maximum extent permitted by law.
This warranty does not apply to any Product which has not been installed or used in accordance with the Product operation 
and installation specifications provided to Buyer verbally or in writing by Alicat Scientific for the proper and normal use of 
the Product.
Buyer agrees hereunder that Alicat reserves the right to void any warranty, written or implied, if upon Alicat’s examination of 
Product shall disclose to Alicat’s satisfaction that the Product failure was due solely, or in part, to accident, misuse, neglect, 
abuse, alteration, improper installation, unauthorized repair or improper testing by Buyer or agent of Buyer.
Alicat Scientific shall not be liable under any circumstances for indirect, special, consequential, or incidental damages in 
connection with, or arising out of, the sale, performance, or use of the Products covered by this warranty.
Alicat Scientific does not recommend, warrant or assume responsibility for the use of the Products in life support applications 
or systems.
Alicat’s warranties as herein above set forth shall not be enlarged, diminished or affected by, and no obligation or liability 
shall arise or grow out of Alicat’s rendering of technical advice in connection with Buyer’s order of the Products furnished 
hereunder.
If Product becomes obsolete, Alicat Scientific, at its own discretion, reserves the right to repair the Product with available 
replacement parts or upgrade the Product to a current, commercially available version of the original Product. Should 
upgrading the Product be deemed necessary by Alicat, Buyer hereby agrees to pay an upgrade fee equal to seventy percent 
of the retail value of the replacement Product. Alicat Scientific hereunder makes no claim that replacement Products will 
look, function or operate in the same or similar manner as the original product.
When a Product is returned to Alicat Scientific for recalibration this service is considered normal preventative maintenance. 
Recalibration of Product shall not be treated as a warranty service unless recalibration of Product is required as the result 
of repairs to Product pursuant to this Warranty. Failure to recalibrate Product on a yearly basis will remove any and 
all obligations regarding repair or replacement of Product as outlined by this Warranty to Buyer from Alicat 
Scientific.
This Warranty is in lieu of all other relevant warranties, expressed or implied, including the implied warranty of merchantability 
and the implied warranty of fitness for a particular purpose, and any warranty against infringement of any patent.
Continued use or possession of Products after expiration of the applicable warranty period stated above shall be conclusive 
evidence that the warranty is fulfilled to the full satisfaction of Buyer. 
Alicat makes no warranty as to experimental, non-standard or developmental Products.
Accessories purchased from Alicat are not covered by this warranty.

Notice: Alicat Scientific, Inc. reserves the right to make any changes and improvements to the products described in this 
manual at any time and without notice. This manual is copyrighted. This document may not, in whole or in part, be copied, 
reproduced, translated, or converted to any electronic medium or machine readable form, for commercial purposes, 
without prior written consent from the copyright holder.
Note: Although we provide assistance on Alicat Scientific products both personally and through our literature, it is the 
complete responsibility of the user to determine the suitability of any product to their application.
Alicat Scientific, Inc.’s Wide-Range Laminar Flow Element Patent: The wide-range laminar flow element and products 
using the wide-range laminar flow element are covered by U.S. Patent Number: 5,511,416. Manufacture or use of the 
wide-range laminar flow element in products other than Alicat Scientific products or other products licensed under said 
patent will be deemed an infringement.



Protect your Warranty and Extend the Life of your Product
Failure to follow general safety and operating procedures as presented in this 
document and the manual violates the safety standards and intended use of 
this device and may impair the functionality of the device. The manufacturer 
assumes no liability for the user’s failure to comply with these requirements.

IMPORTANT: The Manual contains information critical to the proper operation 
and maintenance of your device. The information contained in this manual 
should be read and understood by those responsible for the operation and 
maintenance of this device. Save this manual for future reference.

Cautions for Device Applications
Do Not attempt to disassemble, substitute parts or perform unauthorized 
modifications to this device. Doing so will void the warranty. This device 
contains no user serviceable components and should be serviced by authorized 
personnel only.

Do Not use this device in explosive, wet or corrosive environments.

Do Not flow any corrosive gases such as: Ammonia, Propylene, HCl, SO2, 
H2S, NO2, NO, Silane, Chlorine, etc.

Do Not flow gas in conditions that can cause condensing water vapor to be 
trapped inside the unit as the pressure sensors can be destroyed.

Do Not use a meter with a flow range beyond what you really need, for 
example: do not use a 1000 liter unit for a 100 liter application.

Do size your meter so that nominal flow rate is approximately 70% of the full 
scale flow rating of the meter.

Cautions for Device Installations
Do Not use snap shutting/opening valves where the unit can be exposed 
to high pressure transients — this is especially important for low flow range 
(50SCCM and lower) units with tiny flow channels — damage can occur to the 
differential pressure sensor.

Do Not use a controller's valve assembly for leverage when tightening or 
removing fittings — the valve is a precision device, any bend in the valve stem 
will affect the controlling capability of the unit.

Do Not expose the unit’s outer surface to any liquids, the unit does not have a 
water tight electronics package.

Do power your unit with the correct polarity, voltage & amperage.

Do carefully check your wiring hookups before power up when using a DC-61 
or other blunt cut cable.

Do use a filter system upstream of the unit if possible (20 – 50 microns).

(continued on back)



Advice for Device Operation
Do take note of what gas calibration setting is selected on mass and 
volumetric devices.

Do consider that changing or mixing gases can reduce accuracy and give 
unexpected results with mass and volumetric devices. Please see the 
manual for instructions on correcting to alternate gas viscosities.

Do tare the unit often, while making sure there is absolutely no flow during 
the tare (a controller will tare on a zero setpoint command).

Do keep the unit under 125 PSIG. For pressure gauges and pressure 
controllers the unit’s pressure should be within its full scale range. Units 
special ordered for low pressure use may have reduced pressure limits.

Do keep units running for best performance.

Do consider adjusting your controller’s P & D valve settings to suit your 
system's requirements, note the initial settings before adjustment.

NEVER leave a controller with a non-zero setpoint if no pressure is available 
to make flow. The controller will apply full power to the valve in an attempt to 
reach the setpoint. This can make the valve very hot.

Do follow your recalibration schedule.

Please contact us with your questions. We are happy to help!

info@alicatscientific.com

tel: 520-290-6060  or  888-290-6060

5/06/04 DOC-PROTECT Rev 0
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Thank you for purchasing an M or V Series Gas Flow Meter. Please take the time to find and read the 
information contained in this manual. This will help to ensure that you get the best possible service from 
your instrument. This manual covers the following Alicat Scientific instruments:

 M Series 16 Bit Mass Gas Flow Meters  M-XXSCCM-D
        M-XXSLPM-D
 V Series 16 Bit Volumetric Gas Flow Meters V-XXCCM-D
        V-XXLPM-D
 Alicat Portable Gas Flow Meters

(Note: All Alicat Portable Gas Flow Meters operate in acccordance with the instructions found 
in this manual. Please see page 39 for information regarding battery replacement.)

Installation
Plumbing

All M and V Series Gas Flow Meters are equipped with female inlet and outlet port connections. Because 
the flow meters set up a laminar flow condition within the flow body, no straight runs of pipe are required 
upstream or downstream of the meter. The inlet and outlet ports are equal in size and symmetric 
(in-line). The port sizes (process connections) and mechanical dimensions for different flow ranges are 
shown on pages 31-34.

Meters with M5 (10-32) ports have o-ring face seals and require no further sealant or tape. On 
other meters, avoid the use of pipe dopes or sealants on the ports as these compounds can cause 
permanent damage to the meter should they get into the flow stream. Use of thread sealing Teflon tape 
is recommended to prevent leakage around the threads. When applying the tape, avoid wrapping the 
first thread or two to minimize the possibility of getting a piece of shredded tape into the flow stream. 
When changing fittings, always clean any tape or debris from the port threads.

It is also recommended that a 20 micron filter be installed upstream of meters with full scale ranges 
of 1(S)LPM or less and a 50 micron filter be installed upstream of meters with full scale ranges above 
1(S)LPM.

Mounting

All M and V Series Gas Flow Meters have mounting holes for convenient mounting to flat panels. These 
meters are position insensitive and can be mounted in any orientation. The sizes and dimensions for 
the mounting holes are shown on pages 35-37.

Application

Maximum operating line pressure is 145 PSIG (1 MPa).

Caution: Exceeding the maximum specified line pressure may cause permanent damage to the 
solid-state differential pressure transducer.

If the line pressure is higher than 145 PSIG (1 MPa), a pressure regulator should be used upstream 
from the flow meter to reduce the pressure to 145 PSIG (1 MPa) or less if possible. Although the meter’s 
operation is uni-directional, reversing the flow direction will inflict no damage as long as the maximum 
specified limits are not exceeded.

Note: Avoid installations (such as snap acting solenoid valves upstream) that apply instantaneous 
high pressure to the meter as permanent damage to the differential pressure sensor could result. 
This damage is not covered under warranty!
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Power and Signal Connections

Power can be supplied to your M or V Series meter through either the power jack or the 8 pin Mini-DIN 
connector as shown in Figure 1. An AC to DC adapter which converts line AC power to DC voltage 
between 7 and 30 volts is required to use the power jack (Note: minimum 15Vdc required for 4-20mA 
outputs). The adapter current should be at least 100mA. The power jack accepts 2.1 mm female power 
plugs with positive centers. Cables and AC/DC adaptors maybe purchased from Alicat (see Accessories 
page 42) and are commonly available at local electronics suppliers. Alternatively, power can be supplied 
through the Mini-DIN connector as shown below:

7 8

1 2

3 4 5

AC/DC Adapter Jack

6

1

3

2

4 5

6 7 8

Pin Function Mini-DIN 
cable color

1 Inactive or 4-20mA Primary Output Signal Black

2 Static 5.12 Vdc or Secondary Analog Output (4-20mA, 5Vdc, 10Vdc) or 
Basic Alarm Brown

3 RS-232 Input Signal Red
4 Analog Input Signal = Remote Tare (Ground to Tare) Orange
5 RS-232 Output Signal Yellow
6 0-5 Vdc (or 0-10 Vdc) Output Signal Green
7 Power In (7-30 Vdc, 100mA) or (15-30Vdc for 4-20mA units) Blue
8 Ground (common for power, communications and signals) Purple

Note: The above pin-out is applicable to all the flow meters and controllers available with the Mini-
DIN connector. The availability of different output signals depends on the flow meter options ordered.
Underlined Items in the above table are optional configurations that are noted on the unit’s 
calibration sheet.

Figure 1. 8 Pin Mini-DIN Connector

CAUTION:Do not connect power to pins 1 through 6 as permanent damage can occur!

Note: Upon initial review of the pin out diagram in Figure 1, it is common to mistake Pin 2 (labeled 5.12 
Vdc Output) as the standard 0-5 Vdc analog output signal! In fact Pin 2 is normally a constant 5.12 Vdc 
that reflects the system bus voltage and can be used as a source for the set-point signal.
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RS-232 Digital Output Signal

If you will be using the RS-232 output signal, it is necessary to connect the RS-232 Output Signal 
(Pin 5), the RS-232 Input Signal (Pin 3), and Ground (Pin 8) to your computer serial port as shown in 
Figure 2. Adapter cables are available from the manufacturer or they can be constructed in the field with 
parts from an electronics supply house. In Figure 2, note that the diagrams represent the “port” side of 
the connections, i.e. the connector on top of the meter and the physical DB-9 serial port on the back of 
the computer. The cable ends will be mirror images of the diagram shown in Figure 2. (See page 17 for 
details on accessing RS-232 output.)

Standard Voltage (0-5 Vdc) Output Signal

All M and V series flow meters have a 0-5 Vdc (optional 0-10 Vdc) output signal available on Pin 6. This 
is generally available in addition to other optionally ordered outputs. This voltage is usually in the range 
of 0.010 Vdc for zero flow and 5.0 Vdc for full-scale flow. The output voltage is linear over the entire 
range. Ground for this signal is common on Pin 8.

Optional 0-10 Vdc Output Signal

If your meter was ordered with a 0-10 Vdc output signal, it will be available on Pin 6.  (See the Calibration 
Data Sheet that shipped with your meter to determine which output signals were ordered.) This voltage 
is usually in the range of 0.010 Vdc for zero flow and 10.0 Vdc for full-scale flow. The output voltage is 
linear over the entire range. Ground for this signal is common on Pin 8.

Optional Current (4-20 mA) Output Signal

If your meter was ordered with a 4-20 mA current output signal, it will be available on Pin 1. (See the 
Calibration Data Sheet that shipped with your meter to determine which output signals were ordered.) 
The current signal is 4 mA at 0 flow and 20 mA at the meter’s full scale flow. The output current is 
linear over the entire range. Ground for this signal is common on Pin 8. (Current output units require 
15-30Vdc power.)

Note: This is a current sourcing device. Do not attempt to connect it to “loop powered “ systems.

Optional 2nd Analog Output Signal

You may specify an optional 2nd analog output on Pin 2 at time of order. (See the Calibration Data 
Sheet that shipped with your meter to determine which output signals were ordered.) This output may 
be a 0-5 Vdc, 0-10 Vdc, or 4-20 mA analog signal that can represent any measured parameter. With this 
optional output, a volumetric flow meter could output the volumetric flow rate with a 0-5 Vdc signal (on 
pin 6) and a 4-20 mA signal (on pin 2), or a mass flow meter could output the mass flow rate (0-5 Vdc 
on pin 6) and the absolute pressure (0-5 Vdc on pin 2).

Note: This is a current sourcing device. Do not attempt to connect it to “loop powered “ systems.
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7

4

6

21

DB-9 Serial Port

5

5----------Ground--------------------------------------Ground----------8
3----------Transmit------------------------------------Receive---------3
2----------Receive-------------------------------------Transmit--------5

8 Pin Mini-DIN Port

8

1 2 3 4 5

6 7 8 9
3

 

4 5
6 7 8

2

Figure 2. Mini-DIN to DB-9 Connection for RS-232 Signals

5
3

2

Purple

Red
Yellow

Purple

Red
Yellow

5 4 3 2
1

9
8 7

6

Unit C

Unit B

Unit A

Female Serial Cable Front

Purple (Ground)

Red
Yellow

Figure 3.  Typical Multiple Device (Addressable) Wiring Configuration

Note: The easiest way to connect multiple devices is with a Multi-Drop Box (see page 40).
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An optional industrial connector is also available:

1
6

5

4
3

2

Pin Function Cable Color
1 Power In  ( + ) Red
2 RS-232 Output Blue
3 RS-232 Input Signal White
4 Remote Tare (Ground to Tare) Green
5 Ground (common for power,

                     communications and signals)
Black

6 Signal Out (Voltage or Current as ordered) Brown

Figure 4. Optional Industrial Connector

Note: The above pin-out is applicable to all the flow meters and controllers ordered with the industrial 
connector. The availability of different output signals depends on the flow meter options ordered.

Figure 5. Proper set up for remote tare on meters (Momentarily ground Pin 4 to Tare)

DB15 Pin-out Diagrams: 

Pin-out diagrams for devices ordered with a DB15 
connector can be found on pages 43 and 44 .
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M Series Mass Flow Meter Operation

The M Series Mass Flow Meter provides a multitude of useful flow data in one simple, rugged device. 
The M Series can have several screen “modes” depending on how the device is ordered. All M Series 
meters have a default Main Mode, Select Menu Mode, a Gas Select Mode (the Gas Select Mode 
may not be available on meters calibrated for a custom gas or blend), a Communication Select Mode, 
Manufacturer Data Mode and a Miscellaneous Mode. In addition, your device may have been ordered 
with the optional Totalizing Mode (page 38). The device defaults to Main Mode as soon as power is 
applied to the meter.

Main Mode
The main mode screen defaults on power up with the mass flow on the primary display. The following 
parameters are displayed in the main mode as shown in Figure 6:

 PSIA         oC          Tare
   +13.49      +22.73

       MASS
       SCCM
          Air
    
  +0.000       +0.000
  Volume         Mass       Main

Figure 6. Main Mode Display, M Series Flow Meter
The “MODE” button in the lower right hand corner toggles the display between the Main display and the 
Select Menu display.
Tare – Pushing the dynamically labeled “Tare” button in the upper right hand corner tares the flow meter 
and provides it with a reference point for zero flow. This is a simple but important step in obtaining 
accurate measurements. It is good practice to “zero” the flow meter each time it is powered up. If the 
flow reading varies significantly from zero after an initial tare, give the unit a minute or so to warm up 
and re-zero it.
If possible, zero the unit near the expected operating pressure by positively blocking the flow downstream 
of the flow meter prior to pushing the “Tare” button. Zeroing the unit while there is any flow will directly 
affect the accuracy by providing a false zero point. If in doubt about whether a zero flow condition exists, 
remove the unit from the line and positively block both ports before pressing the “Tare” button. If the unit 
reads a significant negative value when removed from the line and blocked, it is a good indication that 
it was given a false zero. It is better to zero the unit at atmospheric pressure and a confirmed no flow 
conditions than to give it a false zero under line pressure.
Note: A remote tare can be achieved by momentarily grounding pin 4 to tare as shown in Figure  5 on 
page 9.



11

Gas Absolute Pressure: The M Series flow meters utilize an absolute pressure sensor to measure 
the line pressure of the gas flow being monitored. This sensor references hard vacuum and accurately 
reads line pressure both above and below local atmospheric pressure. This parameter is located in 
the upper left corner of the display under the dynamic label “PSIA”. This parameter can be moved to 
the primary display by pushing the button just above the dynamic label (top left). The engineering unit 
associated with absolute pressure is pounds per square inch absolute (PSIA). This can be converted 
to gage pressure (psig = the reading obtained by a pressure gauge that reads zero at atmospheric 
pressure) by simply subtracting local atmospheric pressure from the absolute pressure reading:

   PSIG = PSIA – (Local Atmospheric Pressure)

The flow meters use the absolute pressure of the gas in the calculation of the mass flow rate. For 
working in metric units, note that 1 PSI = 6.89 kPa.

Gas Temperature: The M Series flow meters also utilize a temperature sensor to measure the line 
temperature of the gas flow being monitored. The temperature is displayed in engineering units of 
degrees Celsius (°C). The flow meters use the temperature of the gas in the calculation of the mass 
flow rate. This parameter is located in the upper middle portion of the display under “°C”. This parameter 
can be moved to the primary display by pushing the top center button above “°C”.

Volumetric Flow Rate: The volumetric flow rate is determined using the Flow Measurement Operating 
Principle described elsewhere in this manual. This parameter is located in the lower left corner of the 
display over “Volume”. This parameter can be moved to the primary display by pushing the “Volume” 
button (lower left). In order to get an accurate volumetric flow rate, the gas being measured must be 
selected (see Gas Select Mode). This is important because the device calculates the flow rate based on 
the viscosity of the gas at the measured temperature. If the gas being measured is not what is selected, 
an incorrect value for the viscosity of the gas will be used in the calculation of flow, and the resulting 
output will be inaccurate in direct proportion to the ratio between the two gases viscosities.

Mass Flow Rate: The mass flow rate is the volumetric flow rate corrected to a standard temperature 
and pressure (typically 14.696 psia and 25°C). This parameter is located in the lower middle portion 
of the display over “Mass”. This parameter can be moved to the primary display by pushing the button 
located below “Mass” (bottom center). The meter uses the measured temperature and the measured 
absolute pressure to calculate what the flow rate would be if the gas pressure was at 1 atmosphere and 
the gas temperature was 25°C. This allows a solid reference point for comparing one flow to another.

Flashing Error Message: Our flow meters and controllers display an error message (MOV = mass 
overrange, VOV = volumetric overrange, POV = pressure overrange, TOV = temperature overrange) 
when a measured parameter exceeds the range of the sensors in the device. When any item flashes 
on the display, neither the flashing parameter nor the mass flow measurement is accurate. Reducing 
the value of the flashing parameter to within specified limits will return the unit to normal operation and 
accuracy.
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Select Menu Mode

Pushing “Mode” once will bring up the “Select Menu” display. Push the button nearest your selection to 
go to the corresponding screen. Push “Mode” again to return to the Main Mode display. (Note: If your 
meter was ordered with Totalizing Mode option (page 38), pushing the “Mode” button once will bring up 
the “Totalizing Mode” display.  Pushing “Mode” a second time will bring up the “Select Menu” display.)

Gas    Misc

SELECT
MENU

Comm.      Mfg.
RS232      Data      Menu

Figure 7. Select Menu Display
Gas Select Mode
The gas select mode is accessed by pressing the button above “Gas” on the Select Menu display. The 
screen will appear as shown in Figure 8 below.

 PgUP     PgDWN      Main
   H2  Hydrogen
   He  Helium
  >N2  Nitrogen
   N2O  Nitrous Oxide
   Ne  Neon
   O2  Oxygen
   UP       DOWN      Gas

Figure 8. Gas Select Display
The selected gas is displayed on the default main mode screen as shown in Figure 6, and is indicated 
by the arrow in the Gas Select Mode screen in Figure 8. To change the selected gas, use the buttons 
under “UP” and “DOWN” or above “PgUP” and “PgDWN” to position the arrow in front of the desired 
gas. When the mode is cycled back to the Main Mode, the selected gas will be displayed on the main 
screen. (Note: Gas Select Mode may not be available for units ordered for use with a custom gas or 
blend.)
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Communication Select

The Communication Select mode is accessed by pressing the button below “Comm. RS-232” on the 
Select Menu display. The screen will appear as shown in Figure 9 below.

Select

>
 Unit ID (A).....A
 Baud (19200)....19200
 Data Rate......Fast

Comm.
   UP       DOWN    RS-232

Figure 9. Communication Select Display

Unit ID – Valid unit identifiers are letters A-Z and @ (see Note below). This identifier allows the user 
to assign a unique address to each device so that multiple units can be connected to a single RS-232 
port on a computer. The Communication Select Mode allows you to view and/or change a unit’s unique 
address. To change the unit ID address, press the “Select” button in the upper left corner of the display 
until the cursor arrow is in front of the word “Unit ID”. Then, using the UP and DOWN buttons at the 
bottom of the display, change the unit ID to the desired letter. Any ID change will take effect when the 
Communication Select Screen is exited by pushing the MODE or Main button.

Note: When the symbol @ is selected as the unit ID, the device will go into streaming mode when 
the Communication Select Mode is exited by pushing the MODE or Main button. See the RS-232 
Communications chapter in this manual for information about the streaming mode.

Baud – The baud rate (bits per second) determines the rate at which data is passed back and forth 
between the instrument and the computer. Both devices must send/receive at the same baud rate in 
order for the devices to communicate via RS-232. The default baud rate for these devices is 19200 
baud, sometimes referred to as 19.2K baud. To change the baud rate in the Communication Select 
Mode, press the “Select” button in the upper left corner of the display until the cursor arrow is in front 
of the word “Baud”. Then, using the UP and DOWN buttons at the bottom of the display, select the 
required baud rate to match your computer or PLC. The choices are 38400, 19200, 9600, or 2400 baud.
Any baud rate change will not take effect until power to the unit is cycled.

Data Rate – Changing the Data Rate affects the rate at which the instrument dumps its data. Slow is 
½ the Fast rate. The speed of the Fast rate is determined by the selected baud rate. It is sometimes 
desirable to reduce the data rate if the communication speed bogs down the computer’s processor (as 
is not uncommon in older laptops), or to reduce the size of data files collected in the streaming mode. 
To change the data rate in the Communication Select Mode, press the “Select” button in the upper left 
corner of the display until the cursor arrow is in front of the word “Data Rate”.  Then, using the UP and 
DOWN buttons at the bottom of the display, select either Fast or Slow. Any data rate change will be 
effective immediately upon changing the value between Fast and Slow.
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Manufacturer Data

“Manufacturer Data” is accessed by pressing the “Mfg. Data” button on the Select Menu display 
(Figure 7). The “Mfg 1” display shows the name and telephone number of the manufacturer. The“Mfg 2” 
display shows important information about your flow meter including the model number, serial number, 
and date of manufacture. 

Main

Alicat Scientific, Inc.

Ph 520-290-6060
Fax 520-290-0109

Mfg 1

Main

Model MC-10SLPM-D
Serial No 27117
Date Mfg.11/07/2005
Calibrated By.DL

Software GP07R23 
Mfg 2

Figure 10. Manufacturer Data Displays

Miscellaneous Mode
The Miscellaneous mode is accessed by pressing the button above the “Misc” label in the upper right 
hand corner of the Select Menu display. The screen will appear as shown in Figure 11. Push the button 
above “Select” to move the cursor even with the item you wish to adjust. Then use the “UP” and “DOWN” 
buttons to make the adjustment.

NOTE: All Miscellaneous changes are recorded when you exit the Miscellaneous display.
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Select    Main
>
LCD Contrast(10)   .  10
PVM DBand (0.5% FS)
PRESS Avg (008) . . . 008
FLOW Avg (100) . . . . 100

UP        DOWN      Misc

Figure 11. Miscellaneous Display
LCD Contrast: The Liquid Crystal Display Contrast can be adjusted between 0 and 30 with zero being 
the lightest contrast and 30 being the darkest contrast. To change the contrast, press the “Select” 
button in the upper left hand corner of the display until the cursor arrow is in front of the words “LCD 
Contrast (X)”. Then using the UP and DOWN buttons at the bottom of the display, change the contrast 
value as desired. The change is immediate and the effect can be monitored as the value is changed.
Display Zero Deadband: Zero deadband refers to a value below which the display simply jumps to 
zero. This deadband is often desired to prevent electrical noise from showing up on the display as minor 
flows or pressures that do not actually exist, especially in high noise (electrical) environments. This 
display deadband does not affect the analog or digital signal outputs — there is no zero deadband on the 
output signals. The display zero deadband can be adjusted between 0 and 3.2% of the Full Scale (FS) 
of the sensor. PVM refers to Pressure, Volumetric Flow and Mass Flow, the three parameters to which 
the deadband applies. To adjust the display zero deadband, press the “Select” button in the upper left 
hand corner of the display until the cursor arrow is in front of the words “PVM DBand (X %F.S.)”. Then 
using the UP and DOWN buttons at the bottom of the display, change the display zero deadband value 
as desired.
Pressure Averaging: It is sometimes advantageous to apply an averaging factor to the pressure output 
(and display) to make it easier to read and interpret rapidly fluctuating pressures. Pressure averaging 
can be adjusted between 1 (no averaging) and 256 (maximum averaging). This is a geometric running 
average where the number between 1 and 256 can be considered very roughly equivalent to the 
response time constant in milliseconds. This can be very effective at “smoothing” high frequency process 
oscillations such as those caused by diaphragm pumps. To adjust the pressure averaging, press the 
“Select” button in the upper left hand corner of the display until the cursor arrow is in front of the words 
“PRESS Avg (XXX)”. Then using the UP and DOWN buttons at the bottom of the display, change the 
pressure averaging value as desired.
Flow Averaging: It is sometimes advantageous to apply an averaging factor to the flow output (and 
display) to make it easier to read and interpret rapidly fluctuating flows. Flow averaging can be adjusted 
between 1 (no averaging) and 256 (maximum averaging). This is a geometric running average where 
the number between 1 and 256 can be considered very roughly equivalent to the response time constant 
in milliseconds. This can be very effective at “smoothing” high frequency process oscillations such as 
those caused by diaphragm pumps. To adjust the flow averaging, press the “Select” button in the upper 
left hand corner of the display until the cursor arrow is in front of the words “FLOW Avg (XXX)”. Then 
using the UP and DOWN buttons at the bottom of the display, change the flow averaging value as 
desired.
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V Series Volumetric Flow Meter Operation

The V Series can have several screen “modes” depending on how the device is ordered. All V Series 
meters have a default Main Mode, Select Menu Mode, a Gas Select Mode (the Gas Select Mode 
may not be available on meters calibrated for a custom gas or blend), a Communication Select Mode, 
Manufacturer Data Mode and a Miscellaneous Mode. In addition, your device may have been ordered 
with the optional Totalizing Mode (page 38). The device defaults to Main Mode as soon as power 
is applied to the meter. Note that volumetric meters are intended for use in near atmospheric 
conditions (Please see page 28).

Main Mode

The main mode screen shows the volumetric flow in the units specified at time of order. In the flow 
mode, only two buttons are active as shown in Figure 12. The process gas that is selected is shown 
directly under the flow units.

                                                           Tare

                     Volume
                        CCM
                        Air

  +0.000
  Volume              Main

Figure 12. Main Mode Display, V Series Flow Meter

The “MODE” button in the lower right hand corner toggles the display between the Main Display and 
the Menu Display.

Tare – Pushing the dynamically labeled “Tare” button in the upper right hand corner tares the flow meter 
and provides it with a reference point for zero flow. This is a simple but important step in obtaining 
accurate measurements. It is good practice to “zero” the flow meter each time it is powered up and 
whenever a known zero flow condition exists. If the flow reading varies significantly from zero after an 
initial tare, give the unit a minute or so to warm up and re-zero it.

Zeroing the unit while there is any flow will directly affect the accuracy by providing a false zero point. 
If in doubt about whether a zero flow condition exists, remove the unit from the line and positively block 
both ports before pressing the “Tare” button. If the unit reads a significant negative value when removed 
from the line and blocked, it is a good indication that it was given a false zero. It is better to zero the 
unit at atmospheric pressure and a confirmed “no flow” condition than to give it a false zero under line 
pressure.

Note: A remote tare can be achieved by momentarily grounding pin 4 to tare as shown in Figure 5 on 
page 9.
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Flashing Error Message: Our volumetric flow meters and controllers display an error message 
(VOV =  volumetric overrange) when a measured parameter exceeds the range of the sensors in the 
device. When any item flashes on the display, the flashing parameter is not accurate. Reducing the 
value of the flashing parameter to within specified limits will return the unit to normal operation and 
accuracy.
Select Menu Mode
Pushing “Mode” once will bring up the “Select Menu” display (Figure 7, page 12). Push the button 
nearest your selection to go to the corresponding screen. Push “Mode” again to return to the Main 
Mode display. (Note: If your meter was ordered with Totalizing Mode option (page 38), pushing the 
“Mode” button once will bring up the “Totalizing Mode” display.  Pushing “Mode” a second time will bring 
up the “Select Menu” display.)
Gas Select Mode
The Gas Select Mode is accessed by pressing the button above “Gas Select” on the Select Menu 
display. The screen will appear as shown in Figure 8 (page 12). The selected gas is displayed on the 
default main mode screen as shown in Figure 11, and is indicated by the arrow in the gas select mode 
screen in Figure 8. To change the selected gas, use the buttons under “UP” and “DOWN” or those 
above “PgUP” and “PgDWN” to position the arrow in front of the desired gas. When the mode is cycled 
back to the main mode, the selected gas will be displayed on the main screen. 
Note: Gas Select Mode may not be available for units ordered for use with a custom gas or blend.
Communication Select Mode
The Communication Select mode is accessed by pressing the button below “Comm. RS-232” on the 
Select Menu display. Please see page 13 for Communication Select mode instructions.
Manufacturer Data Mode
“Manufacturuer Data” is accessed by pressing the “Mfg. Data” button on the Select Menu display 
(Figure 7,page 12). The “Mfg 1” display shows the name and telephone number of the manufacturer. 
The“Mfg 2” display shows important information about your flow meter including the model number, 
serial number, and date of manufacture (Figure 10, page 14). 
Miscellaneous Mode
The Miscellaneous mode is accessed by pressing the button above the “Misc” label in the upper right 
hand corner of the Select Menu display. The screen will appear as shown in Figure 11. Push the 
button above “Select” to move the cursor even with the item you wish to adjust. Then use the “UP” and 
“DOWN” buttons to make the adjustment. See pages 14 & 15.

NOTE: All Miscellaneous changes are recorded when you exit the Miscellaneous display.

RS-232 Output and Input
Configuring HyperTerminal®:

Open your HyperTerminal® RS-232 terminal program (installed under the “Accessories” menu on 1. 
all Microsoft Windows® operating systems).
Select “Properties” from the file menu.2. 
Click on the “Configure” button under the “Connect To” tab. Be sure the program is set for: 19,200 3. 
baud (or matches the baud rate selected in the RS-232 communications menu on the meter) and 
an 8-N-1-None (8 Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.
Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI or Auto Detect.4. 
Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line Feeds” box 5. is not 
checked and the “Echo Typed Characters Locally” box and the “Append Line Feeds to Incoming 
Lines” boxes are checked. Those settings not mentioned here are normally okay in the default 
position.
Save the settings, close HyperTerminal® and reopen it.6. 
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In Polling Mode, the screen should be blank except the blinking cursor. In order to get the data streaming 
to the screen, hit the “Enter” key several times to clear any extraneous information. Type “*@=@” 
followed by “Enter” (or using the RS-232 communcation select menu, select @ as identifier and exit the 
screen). If data still does not appear, check all the connections and com port assignments.

Changing From Streaming to Polling Mode: 
When the meter is in the Streaming Mode, the screen is updated approximately 10-60 times per second 
(depending on the amount of data on each line) so that the user sees the data essentially in real time. 
It is sometimes desirable, and necessary when using more than one unit on a single RS-232 line, to be 
able to poll the unit.

In Polling Mode the unit measures the flow normally, but only sends a line of data when it is “polled”. 
Each unit can be given its own unique identifier or address. Unless otherwise specified each unit is 
shipped with a default address of capital A. Other valid addresses are B thru Z.

Once you have established communication with the unit and have a stream of information filling your 
screen:

Type *@=A followed by “Enter” (or using the RS-232 communcation select menu, select A as identifier 1. 
and exit the screen) to stop the streaming mode of information. Note that the flow of information will 
not stop while you are typing and you will not be able to read what you have typed. Also, the unit 
does not accept a backspace or delete in the line so it must be typed correctly. If in doubt, simply hit 
enter and start again. If the unit does not get exactly what it is expecting, it will ignore it. If the line 
has been typed correctly, the data will stop.

You may now poll the unit by typing A followed by “Enter”. This does an instantaneous poll of unit 2. 
A and returns the values once. You may type A “Enter” as many times as you like. Alternately you 
could resume streaming mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the 
unit from the streaming mode.

To assign the unit a new address, type *@=New Address, e.g. *@=B. Care should be taken not to 3. 
assign an address to a unit if more than one unit is on the RS232 line as all of the addresses will be 
reassigned. Instead, each should be individually attached to the RS-232 line, given an address, and 
taken off. After each unit has been given a unique address, they can all be put back on the same 
line and polled individually.

Tare –Tareing (or zeroing) the flow meter provides it with a reference point for zero flow. This is a simple 
but important step in obtaining accurate measurements. It is good practice to “zero” the flow meter each 
time it is powered up. A unit may be Tared by following the instructions on page 10 or it may be Tared 
via RS-232 input. 

To send a Tare command via RS-232, enter the following strings:

In Streaming Mode: $$V<Enter>

In Polling Mode: Address$$V<Enter>        (e.g. B$$V<Enter>)
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Gas Select – The selected gas can be changed via RS-232 input. To change the selected gas, enter 
the following commands:

 In Streaming Mode: $$#<Enter>
 In Polling Mode: Address$$#<Enter>    (e.g. B$$#<Enter>)

Where # is the number of the gas selected from the table below. Note that this also corresponds to the 
gas select menu on the flow meter screen:

# GAS
0 Air Air
1 Argon     Ar
2 Methane    CH4
3 Carbon Monoxide    CO
4 Carbon Dioxide    CO2
5 Ethane    C2H6
6 Hydrogen    H2
7 Helium    He
8 Nitrogen    N2
9 Nitrous Oxide    N2O
10 Neon    Ne
11 Oxygen    O2
12 Propane    C3H8
13 normal-Butane    n-C4H10
14 Acetylene    C2H2
15 Ethylene    C2H4
16 iso-Butane i-C2H10
17 Krypton Kr
18 Xenon Xe
19 Sulfur Hexafluoride SF6
20 75% Argon / 25% CO2 C-25
21 90% Argon / 10% CO2 C-10
22 92% Argon / 8% CO2 C-8
23 98% Argon / 2% CO2 C-2
24 75% CO2 / 25% Argon C-75
25 75% Argon / 25% Helium A-75
26 75% Helium / 25% Argon A-25
27 90% Helium / 7.5% Argon / 2.5% CO2

(Praxair - Helistar® A1025)
A1025

28 90% Argon / 8% CO2 / 2% Oxygen
(Praxair - Stargon® CS)

Star29

29 95% Argon / 5% Methane P-5

For example, to select Propane, enter:  $$12<Enter>
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Collecting Data:
The RS-232 output updates to the screen many times per second. Very short-term events can be 
captured simply by disconnecting (there are two telephone symbol icons at the top of the HyperTerminal® 
screen for disconnecting and connecting) immediately after the event in question. The scroll bar can be 
driven up to the event and all of the data associated with the event can be selected, copied, and pasted 
into Microsoft® Excel® or other spreadsheet program as described below.

For longer term data, it is useful to capture the data in a text file. With the desired data streaming to the 
screen, select “Capture Text” from the Transfer Menu. Type in the path and file name you wish to use. 
Push the start button. When the data collection period is complete, simply select “Capture Text” from 
the Transfer Menu and select “Stop” from the sub-menu that appears.

Data that is selected and copied, either directly from HyperTerminal® or from a text file can be pasted 
directly into Excel®. When the data is pasted it will all be in the selected column. Select “Text to 
Columns...” under the Data menu in Excel® and a Text to Columns Wizard (dialog box) will appear. 
Make sure that “Fixed Width” is selected under Original Data Type in the first dialog box and click “Next”. 
In the second dialog box, set the column widths as desired, but the default is usually acceptable. Click 
on “Next” again.  In the third dialog box, make sure the column data format is set to “General”, and click 
“Finish”. This separates the data into columns for manipulation and removes symbols such as the plus 
signs from the numbers. Once the data is in this format, it can be graphed or manipulated as desired. 
For extended term data capture see: “Sending a Simple Script to HyperTerminal®” on page 21.

Data Format:
The data stream on the screen represents the flow parameters of the main mode in the units shown on 
the display. For volumetric flow meters, there are two columns of data representing volumetric flow rate 
in the units specified at time of order and the selected gas.

+4.123 Air
+4.123 Air
+4.123 Air
+4.123 Air
+4.124 Air
+4.125 Air

V Series Volumetric Flow Meter Data Format

For mass flow meters, there are 5 columns of data representing pressure, temperature, volumetric flow, 
mass flow and the selected gas. The first column is absolute pressure (normally in PSIA), the second 
column is temperature (normally in °C), the third column is volumetric flow rate (in the units specified at 
time of order and shown on the display), and the fourth column is mass flow (also in the units specified 
at time of order and shown on the display). For instance, if the meter was ordered in units of SCFM, 
the display on the meter would read 2.004 SCFM and the last two columns of the output below would 
represent volumetric flow and mass flow in CFM and SCFM respectively.

+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air

M Series Mass Flow Meter Data Format
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Sending a Simple Script File to HyperTerminal®
It is sometimes desirable to capture data for an extended period of time. Standard streaming mode 
information is useful for short term events, however, when capturing data for an extended period of 
time, the amount of data and thus the file size can become too large very quickly. Without any special 
programming skills, the user can use HyperTerminal and a text editing program such as Microsoft Word 
to capture text at user defined intervals.

1. Open your text editing program, MS Word for example.
2. Set the cap lock on so that you are typing in capital letters.
3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using MS Word, you can tell how 

many lines you have by the line count at the bottom of the screen. The number of lines will correspond 
to the total number of times the flow device will be polled, and thus the total number of lines of data it 
will produce.

For example: A
 A
 A
 A
 A
 A
will get a total of six lines of data from the flow meter, but you can enter as many as you like.

The time between each line will be set in HyperTerminal.

4. When you have as many lines as you wish, go to the File menu and select save. In the save dialog 
box, enter a path and file name as desired and in the “Save as Type” box, select the plain text (.txt) 
option. It is important that it be saved as a generic text file for HyperTerminal to work with it.

5. Click Save.
6. A file conversion box will appear. In the “End Lines With” drop down box, select CR Only. Everything 

else can be left as default.
7. Click O.K.
8. You have now created a “script” file to send to HyperTerminal. Close the file and exit the text editing 

program.
9. Open HyperTerminal and establish communication with your flow device as outlined in the manual.
10. Set the flow device to Polling Mode as described in the manual. Each time you type A<Enter>, the 

meter should return one line of data to the screen.
11. Go to the File menu in HyperTerminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.
14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will tell the program how often 

to read a line from the script file you’ve created. 1000 milliseconds is one second, so if you want a line 
of data every 30 seconds, you would enter 30000 into the box. If you want a line every 5 minutes, you 
would enter 300000 into the box.

15. When you have entered the value you want, click on OK and OK in the Properties dialog box.
16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).
17. Browse and select the text “script” file you created.
18. Click Open.
19. The program will begin “executing” your script file, reading one line at a time with the line delay you 

specified and the flow device will respond by sending one line of data for each poll it receives, when it 
receives it.

You can also capture the data to another file as described in the manual under “Collecting Data”. You 
will be simultaneously sending it a script file and capturing the output to a separate file for analysis.
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Operating Principle

All M and V Series Gas Flow Meters are based on the accurate measurement of volumetric flow. The 
volumetric flow rate is determined by creating a pressure drop across a unique internal restriction, 
known as a Laminar Flow Element (LFE), and measuring differential pressure across it. The restriction 
is designed so that the gas molecules are forced to move in parallel paths along the entire length of the 
passage; hence laminar (streamline) flow is established for the entire range of operation of the device. 
Unlike other flow measuring devices, in laminar flow meters the relationship between pressure drop 
and flow is linear. The underlying principle of operation of the 16 Series flow meters is known as the 
Poiseuille Equation:

Q = (P1-P2)�r4/8ηL           (Equation 1)

Where: Q   = Volumetric Flow Rate
  P1  = Static pressure at the inlet
  P2 = Static pressure at the outlet
  r = Radius of the restriction
  η = (eta) absolute viscosity of the fluid
  L = Length of the restriction

Since �, r and L are constant; Equation 1 can be rewritten as:

Q = K (∆P/η)             (Equation 2)

Where K is a constant factor determined by the geometry of the restriction. Equation 2 shows the linear 
relationship between volumetric flow rate (Q) differential pressure (∆P) and absolute viscosity (η) in a 
simpler form.

Gas Viscosity: In order to get an accurate volumetric flow rate, the gas being measured must be 
selected (see Gas Select Mode, page 12). This is important because the device calculates the flow rate 
based on the viscosity of the gas at the measured temperature. If the gas being measured is not what 
is selected, an incorrect value for the viscosity of the gas will be used in the calculation of flow, and the 
resulting output will be inaccurate in direct proportion to the difference in the two gases viscosities.

Gas viscosity, and thus gas composition, can be very important to the accuracy of the meter. Anything 
that has an effect on the gas viscosity (e.g. water vapor, odorant additives, etc.) will have a direct 
proportional effect on the accuracy. Selecting methane and measuring natural gas for instance, will 
result in a fairly decent reading, but it is not highly accurate (errors are typically < 0.6%) because 
natural gas contains small and varying amounts of other gases such as butane and propane that result 
in a viscosity that is somewhat different than pure methane.

Absolute viscosity changes very little with pressure (within the operating ranges of these meters) therefore 
a true volumetric reading does not require a correction for pressure. Changes in gas temperature do 
affect viscosity. For this reason, the M and V Series internally compensate for this change.
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Other Gases: M Series Flow Meters can easily be used to measure the flow rate of gases other than 
those listed as long as “non-corrosive” gas compatibility is observed. For example, a flow meter that 
has been set for air can be used to measure the flow of argon.

The conversion factor needed for measuring the flow of different gases is linear and is simply determined 
by the ratio of the absolute viscosity of the gases. This factor can be calculated as follows:
  Qog = Q1 [η1 / ηog ]

Where: Q1 = Flow rate indicated by the flow meter
  η1 = Viscosity of the calibrated gas at the measured temp.
  Qog = Flow rate of the alternate gas
  ηog = Viscosity of the alternate gas at the measured temp.

Say we have a meter set for air and we want to flow argon through it. With argon flowing through the 
meter, the display reads 110 SLPM.  For ease of calculation, let us say the gas temperature is 25°C. 
What is the actual flow of argon?

  Qog = Actual Argon Flow Rate
  Q1 = Flow rate indicated by meter (110 SLPM)
  η1 = Viscosity of gas selected or calibrated for by the meter at the
    measured temp.
  ηog = Viscosity of gas flowing through the meter at the measured temp.

At 25°C, the absolute viscosity of Air (η1) is 184.918 micropoise.
At 25°C, the absolute viscosity of Argon (ηog) is 225.593 micropoise.

  Qog = Q1 (η 1 / ηog)
  Qog = 110 SLPM (184.918 / 225.593)
  Qog = 90.17 SLPM

So, the actual flow of Argon through the meter is 90.17 SLPM. As you can see, because the Argon gas 
is more viscous than the Air the meter is set for, the meter indicates a higher flow than the actual flow.

A good rule of thumb is: “At a given flow rate, the higher the viscosity, the higher the indicated flow.”

Volume Flow vs. Mass Flow: At room temperature and low pressures the volumetric and mass flow 
rate will be nearly identical, however, these rates can vary drastically with changes in temperature and/
or pressure because the temperature and pressure of the gas directly affects the volume. For example, 
assume a volumetric flow reading was used to fill balloons with 250 mL of helium, but the incoming 
line ran near a furnace that cycled on and off, intermittently heating the incoming helium. Because 
the volumetric meter simply measures the volume of gas flow, all of the balloons would initially be the 
same size. However, if all the balloons are placed in a room and allowed to come to an equilibrium 
temperature, they would generally all come out to be different sizes. If, on the other hand, a mass flow 
reading were used to fill the balloons with 250 standard mL of helium, the resulting balloons would 
initially be different sizes, but when allowed to come to an equilibrium temperature, they would all turn 
out to be the same size.

This parameter is called corrected mass flow because the resulting reading has been compensated 
for temperature and pressure and can therefore be tied to the mass of the gas. Without knowing the 
temperature and pressure of the gas and thus the density, the mass of the gas cannot be determined.
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Once the corrected mass flow rate at standard conditions has been determined and the density at 
standard conditions is known (see the density table at the back of this manual), a true mass flow can 
be calculated as detailed in the following example:

Mass Flow Meter Reading = 250  SCCM (Standard Cubic Centimeters/Minute)
Gas: Helium
Gas Density at 25C and 14.696 PSIA = .16353 grams/Liter
True Mass Flow = (Mass Flow Meter Reading) X (Gas Density)
True Mass Flow = (250 CC/min) X (1 Liter / 1000 CC) X (.16353 grams/Liter)
True Mass Flow = 0.0409 grams/min of Helium

Volumetric and Mass Flow Conversion: In order to convert volume to mass, the density of the gas 
must be known. The relationship between volume and mass is as follows:

Mass = Volume x Density

The density of the gas changes with temperature and pressure and therefore the conversion of 
volumetric flow rate to mass flow rate requires knowledge of density change. Using ideal gas laws, the 
effect of temperature on density is:

  ρa / ρs = Ts / Ta

Where: ρa = density @ flow condition
  Ta = absolute temp @ flow condition in °Kelvin
  ρs = density @ standard (reference ) condition
  Ts = absolute temp @ standard (reference) condition in °Kelvin
  ºK = ºC + 273.15   Note: ºK=ºKelvin

The change in density with pressure can also be described as:

  ρa / ρs = Pa / Ps

Where: ρa = density @ flow condition
  Pa = flow absolute pressure
  ρs = density @ standard (reference ) condition
  Ps = Absolute pressure @ standard (reference) condition

Therefore, in order to determine mass flow rate, two correction factors must be applied to volumetric 
rate: temperature effect on density and pressure effect on density.

Compressibility: Heretofore, we have discussed the gases as if they were “Ideal” in their characteristics.  
The ideal gas law is formulated as: 

PV=nRT  where: P  =  Absolute Pressure
     V  =  Volume (or Volumetric Flow Rate)
     n  =  number moles (or Molar Flow Rate)
     R  = Gas Constant (related to molecular weight)
     T  =  Absolute Temperature

Most gases behave in a nearly ideal manner when measured within the temperature and pressure 
limitations of Alicat products. However, some gases (such as propane and butane) can behave in a less 
than ideal manner within these constraints. The non-ideal gas law is formulated as: 

PV=ZnRT

Where: “Z” is the compressibility factor. This can be seen in an increasingly blatant manner as gases 
approach conditions where they condense to liquid. As the compressibility factor goes down (Z=1 is 
the ideal gas condition), the gas takes up less volume than what one would expect from the ideal gas 
calculation.
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This reduces to: Pa Va / Za Ta = Ps Vs / Zs Ts , eliminating R and n.

Alicat mass flow meters model gas flows based upon the non-ideal gas characteristics of the calibrated 
gas.  The flow corrections are normally made to 25 C and 14.696 PSIA and the compressibility factor 
of the gas under those conditions.  This allows the user to multiply the mass flow rate by the density of 
the real gas at those standard conditions to get the mass flow rate in grams per minute.

Because we incorporate the compressibility factor into our ‘full gas model’; attempts to manually 
compute mass flows from only the P, V, and T values shown on the display will sometimes result in 
modest errors. 

Note: Although the correct units for mass are expressed in grams, kilograms, etc. it has become standard 
that mass flow rate is specified in SLPM (standard liters / minute), SCCM (standard cubic centimeters 
/ minute) or SmL/M (standard milliliters / minute).

This means that mass flow rate is calculated by normalizing the volumetric flow rate to some standard 
temperature and pressure (STP). By knowing the density at that STP, one can determine the mass flow 
rate in grams per minute, kilograms per hour, etc.

STP is usually specified as the sea level conditions; however, no single standard exists for this 
convention. Examples of common reference conditions include:

    0°C and 14.696 PSIA
    25°C and 14.696 PSIA
    0°C and 760 torr (mmHG)
    70°F and 14.696 PSIA
    68°F and 29.92 inHG
    20°C and 760 torr (mmHG)

M Series Flow Meters reference 25ºC and14.696 PSIA (101.32kPa) - unless ordered otherwise. 
Refer to the calibration sheet to confirm the reference point.

Standard Gas Data Tables: Those of you who have older Alicat products (manufactured before 
October 2005) may notice small discrepancies between the gas property tables of your old and new 
units. Alicat Scientific, Inc. has recently incorporated the latest data sets from NIST (including their 
REFPROP 7 data) in our products’ built-in gas property models. Be aware that calibrators that you may 
be spot checking against may be using older data sets such as the widely distributed Air Liquide data.  
This may generate apparent calibration discrepancies of up to 0.6% of reading on well behaved gases 
and as much as 3% of reading on some gases such as propane and butane, unless the standard was 
directly calibrated on the gas in question. As the older standards are phased out of the industry, this 
difference in readings will cease to be a problem. If you see a difference between the Alicat meter and 
your in-house standard, in addition to calling Alicat Scientific at (520) 290-6060, call the manufacturer 
of your standard for clarification as to which data set they used in their calibration. This comparison will 
in all likelihood resolve the problem.
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Gas
Number Short Form Long Form

Viscosity*
25 deg C 

14.696 PSIA

Density**
25 deg C 

14.696 PSIA

Compressibility
 25 deg C 

14.696 PSIA
0 Air Air 184.918 1.1840 0.9997
1 Ar Argon 225.593 1.6339 0.9994
2 CH4 Methane 111.852 0.6569 0.9982
3 CO Carbon Monoxide 176.473 1.1453 0.9997
4 CO2 Carbon Dioxide 149.332 1.8080 0.9949
5 C2H6 Ethane 93.540 1.2385 0.9924
6 H2 Hydrogen 89.153 0.08235 1.0006
7 He Helium 198.457 0.16353 1.0005
8 N2 Nitrogen 178.120 1.1453 0.9998
9 N2O Nitrous Oxide 148.456 1.8088 0.9946
10 Ne Neon 311.149 0.8246 1.0005
11 O2 Oxygen 204.591 1.3088 0.9994
12 C3H8 Propane 81.458 1.8316 0.9841
13 n-C4H10 normal-Butane 74.052 2.4494 0.9699
14 C2H2 Acetylene 104.448 1.0720 0.9928
15 C2H4 Ethylene 103.177 1.1533 0.9943
16 i-C4H10 iso-Butane 74.988 2.4403 0.9728
17 Kr Krypton 251.342 3.4274 0.9994
18 Xe Xenon 229.785 5.3954 0.9947
19 SF6 Sulfur Hexafluoride 153.532 6.0380 0.9887
20 C-25 75% Argon / 25% CO2 205.615 1.6766 0.9987
21 C-10 90% Argon / 10% CO2 217.529 1.6509 0.9991
22 C-8 92% Argon / 8% CO2 219.134 1.6475 0.9992
23 C-2 98% Argon / 2% CO2 223.973 1.6373 0.9993
24 C-75 75% CO2 / 25% Argon 167.451 1.7634 0.9966
25 A-75 75% Argon / 25% Helium 230.998 1.2660 0.9997
26 A-25 75% Helium / 25% Argon 234.306 0.5306 1.0002

27 A1025
90% Helium / 7.5% Argon / 

2.5% CO2 
(Praxair - Helistar® A1025)

214.840 0.3146 1.0003

28 Star29
90% Argon / 8% CO2 

/ 2% Oxygen 
(Praxair - Stargon® CS)

218.817 1.6410 0.9992

29 P-5 95% Argon / 5% Methane 223.483 1.5850 0.9993
*in micropoise (1 Poise = gram / (cm) (sec))       ** Grams/Liter                    (NIST REFPROP 7 database)

Gas Viscosities, Densities and Compressibilities at 25° C
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Gas
Number Short Form Long Form

Viscosity*
0 deg C 

14.696 PSIA

Density**
0 deg C 

14.696 PSIA

Compressibility
 0 deg C 

14.696 PSIA
0 Air Air 172.588 1.2927 0.9994
1 Ar Argon 209.566 1.7840 0.9991
2 CH4 Methane 103.657 0.7175 0.9976
3 CO Carbon Monoxide 165.130 1.2505 0.9994
4 CO2 Carbon Dioxide 137.129 1.9768 0.9933
5 C2H6 Ethane 86.127 1.3551 0.9900
6 H2 Hydrogen 83.970 0.08988 1.0007
7 He Helium 186.945 0.17849 1.0005
8 N2 Nitrogen 166.371 1.2504 0.9995
9 N2O Nitrous Oxide 136.350 1.9778 0.9928
10 Ne Neon 293.825 0.8999 1.0005
11 O2 Oxygen 190.555 1.4290 0.9990
12 C3H8 Propane 74.687 2.0101 0.9787
13 n-C4H10 normal-Butane 67.691 2.7048 0.9587
14 C2H2 Acetylene 97.374 1.1728 0.9905
15 C2H4 Ethylene 94.690 1.2611 0.9925
16 i-C4H10 iso-Butane 68.759 2.6893 0.9627
17 Kr Krypton 232.175 3.7422 0.9991
18 Xe Xenon 212.085 5.8988 0.9931
19 SF6 Sulfur Hexafluoride 140.890 6.6154 0.9850
20 C-25 75% Argon / 25% CO2 190.579 1.8309 0.9982
21 C-10 90% Argon / 10% CO2 201.897 1.8027 0.9987
22 C-8 92% Argon / 8% CO2 203.423 1.7989 0.9988
23 C-2 98% Argon / 2% CO2 208.022 1.7877 0.9990
24 C-75 75% CO2 / 25% Argon 154.328 1.9270 0.9954
25 A-75 75% Argon / 25% Helium 214.808 1.3821 0.9995
26 A-25 75% Helium / 25% Argon 218.962 0.5794 1.0002

27 A1025
90% Helium / 7.5% Argon

 / 2.5% CO2
(Praxair - Helistar® A1025)

201.284 0.3434 1.0002

28 Star29
90% Argon / 8% CO2 

/ 2% Oxygen
(Praxair - Stargon® CS)

203.139 1.7918 0.9988

29 P-5 95% Argon / 5% Methane 207.633 1.7307 0.9990
*in micropoise (1 Poise = gram / (cm) (sec))       ** Grams/Liter                    (NIST REFPROP 7 database)

Gas Viscosities, Densities and Compressibilities at 0° C   
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Volumetric Flow Meters Under Pressure
V Series Volumetric Flow Meters are intended for use in low pressure applications. This is 
because an accurate measurement of the volumetric flow rate by means of differential pressure 
requires the flow at the differential pressure sensor to be in a laminar state. The state of the flow 
is quantified by what is known as the Reynolds Number. If the Reynolds Number gets above a 
certain point, generally accepted as approximately 2000, the flow will become non-laminar. The 
Reynolds Number for a given Newtonian fluid flow is defined as:

   Re = ρVL/η

Where:  ρ = density
   V = average velocity
   L = Constant determined by length and geometry of passage
   η = absolute viscosity

From this relationship we see that increasing the gas density or velocity increases the Reynolds 
Number, and increasing the gas viscosity decreases the Reynolds number. For a given gas in 
a given meter at a given temperature, L and η are roughly fixed constants.

For the purpose of illustration, let us put two 100 (S)LPM flow meters, identical in every way 
except that one is a volumetric flow meter and one is a mass flow meter, in series with one 
another in a pipeline. Now let us pass a small constant air flow through the meters, thus fixing 
the velocity V though both meters. With the flow fixed, let us begin increasing the pressure, 
and thus the density ρ. The mass flow meter, which is measuring the absolute pressure and 
compensating for the density change registers this pressure increase as an increase in mass 
flow rate because the number of molecules of gas keeps going up in the fixed volume of flow. 
In addition, the Reynolds number has increased proportionately with the pressure increase 
because the density goes up with the pressure. If you increase the pressure high enough, 
the mass flow meter will max out at 100 SLPM, the Reynolds number has increased fairly 
dramatically, and the volumetric meter still registers your small fixed flow rate.

Now if we maintain the higher pressure and try to take the volumetric meter up to its published 
full scale flow of 100 LPM, our density ρ AND our velocity V will be high, which often results 
in a high Reynolds number and non-laminar flow. When the flow is non-laminar, the Poiseuille 
Equation upon which we base our volumetric flow measurement is no longer valid and the 
meter reading is therefore no longer valid.

Gas properties also need to be taken into account in deciding whether you can use a volumetric 
flow meter at a particular line pressure. Helium, which has a relatively low density and a 
relatively high viscosity at standard conditions, can generally get away with higher pressures in 
a volumetric flow meter. Propane, on the other hand, has a relatively high density and relatively 
low viscosity making it a considerably more difficult gas to measure at higher pressures in a 
volumetric flow meter. In air, most volumetric meters make valid full scale measurements up to 
10-15 PSIG line pressure.
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TROUBLESHOOTING
Display does not come on or is weak.
Check power  and ground connections.

Flow reading is approximately fixed either near zero or near full scale regardless of actual line 
flow.
Differential pressure sensor may be damaged. Avoid installations that can subject sensor to pressure 
drops in excess of 10 PSID. A common cause of this problem is instantaneous application of high-pressure 
gas as from a snap acting solenoid valve upstream of the meter. Damage due to excessive pressure 
differential is not covered by warranty.

Displayed mass flow, volumetric flow, pressure or temperature is flashing and message MOV, 
VOV, POV or TOV is displayed:
Our flow meters and controllers display an error message (MOV = mass overrange, VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) when a measured parameter 
exceeds the range of the sensors in the device. When any item flashes on the display, neither the 
flashing parameter nor the mass flow measurement is accurate. Reducing the value of the flashing 
parameter to within specified limits will return the unit to normal operation and accuracy.

Meter reads negative flow when there is a confirmed no flow condition.
This is an indication of an improper tare. If the meter is tared while there is flow, that flow is accepted as 
zero flow. When an actual zero flow condition exists, the meter will read a negative flow. Simply re-tare 
at the confirmed zero flow condition. Also note that while the meter is intended for positive flow, it will 
read negative flow with reasonable accuracy (it is not calibrated for bi-directional flow) and no damage 
will result.

Meter does not agree with another meter I have in line.
Volumetric meters will often not agree with one another when put in series because they are affected 
by pressure drops. Volumetric flow meters should not be compared to mass flow meters. Mass flow 
meters can be compared against one another provided there are no leaks between the two meters and 
they are set to the same standard temperature and pressure. Both meters must also be calibrated (or 
set) for the gas being measured. M Series mass flow meters are normally set to Standard Temperature 
and Pressure conditions of 25° C and 14.696 PSIA. Note: it is possible to special order meters with a 
customer specified set of standard conditions. The calibration sheet provided with each meter lists its 
standard conditions.

Flow flutters or is jumpy.
The meters are very fast and will pick up any actual flow fluctuations such as from a diaphragm pump, 
etc. Also, inspect the inside of the upstream connection for debris such a Teflon tape shreds. Note: M & 
V Series meters feature a programmable geometric running average (GRA) that can aid in allowing a 
rapidly fluctuating flow to be read (see “Pressure Averaging” and “Flow Averaging” page 15).

The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the meter as voltage drops in the 
wires increase with distance. Using heavier gauge wires, especially in the ground wire, can reduce this 
effect.

My volumetric meter reading is strange, inconsistent, or incorrect.
Make sure you use a volumetric flow meter only under low pressure (close to atmospheric) and with 
little to no back pressure for accurate readings. Mass meters should be used for higher pressure 
applications. See page 28.
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RS-232 Serial Communications is not responding.
Check that your meter is powered and connected properly. Be sure that the port on the computer to which 
the meter is connected is active. Confirm that the port settings are correct per the RS-232 instructions 
in this manual (Check the RS-232 communications select screen for current meter readings). Close 
HyperTerminal® and reopen it. Reboot your PC.

Slower response than specified.
M and V Series meters feature a programmable Geometric Running Average (GRA). Depending on the 
full scale range of the meter, it may have the GRA set to enhance the stability/readability of the display, 
which would result in slower perceived response time. Please see “Pressure Averaging” and “Flow 
Averaging” on page 15.

Jumps to zero at low flow.
M and V Series meters feature a programmable zero deadband. The factory setting is usually 0.5% of 
full scale. This can be adjusted between NONE and 3.2% of full scale. See “Display Zero Deadband” 
on page 15.

Discrepancies between old and new units.
Please see “Standard Gas Data Tables” explanation on page 25.

Maintenance and Recalibration

General: M and V Series Flow Meters require minimal maintenance. They have no moving parts. The 
single most important thing that affects the life and accuracy of these devices is the quality of the gas 
being measured. The meter is designed to measure CLEAN, DRY, NON-CORROSIVE gases. A 20 
micron filter (50 micron for 50 LPM and up) mounted upstream of the meter is highly recommended. 
Moisture, oil, and other contaminants can affect the laminar flow elements and/or reduce the area that 
is used to calculate the flow rate. This directly affects the accuracy.

Recalibration: The recommended period for recalibration is once every year. Providing that the CLEAN, 
DRY, and NON-CORROSIVE mantra is observed, this periodic recalibration is sufficient. A label located 
on the back of the meter lists the recalibration due date. The meter should be returned to the factory for 
recalibration near the listed due date. Before calling to schedule a recalibration, please note the serial 
number on the back of the meter. The Serial Number, Model Number, and Date of Manufacture are also 
available on the Manufacture Data 2 screen (page 14).

Cleaning: M and V Series Flow Meters require no periodic cleaning. If necessary, the outside of the 
meter can be cleaned with a soft dry rag. Avoid excess moisture or solvents.

For repairs, recalibrations, or recycling of this product, contact:

Alicat Scientific, Inc.
2045 N Forbes Blvd. Bldg.103

Tucson, Arizona 85745
USA

Ph. 520-290-6060
Fax 520-290-0109

email: info@alicatscientific.com
Web site: www.alicatscientific.com
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Dimensional Drawings: page 35

Specification Mass
Meter

Volumetric
Meter Description

Accuracy ± (0.8% of Reading + 0.2% of Full Scale) At calibration conditions after tare

High Accuracy Option ± (0.4% of Reading + 0.2% of Full Scale) At calibration conditions after tare

Accuracy: Bi-directional 
Meters Only

± (0.8% of reading + 0.2% of total span 
positive full scale to negative full scale) At calibration conditions after tare

Repeatability ± 0.2% Full Scale
Operating Range 1% to 100% Full Scale Measure

Typical Response Time 10 Milliseconds (Adjustable)
Standard Conditions (STP) 25ºC & 14.696PSIA Not Applicable Mass Reference Conditions

Operating Temperature −10 to +50 ºCelsius
Zero Shift 0.02% Full Scale / ºCelsius / Atm

Span Shift 0.02% Full Scale / ºCelsius / Atm
Humidity Range 0 to 100% Non–Condensing

Measurable Flow Rate 128% Full Scale
Maximum Pressure 145 1451 PSIG

Output Signal Digital Mass, Volume,
Pressure & Temperature Volumetric Flow RS-232 Serial

Output Signal Analog Mass Flow Volumetric Flow 0-5Vdc 

Optional Output Signal 
Secondary Analog

Mass, Volumetric 
Pressure or 
Temperature

Volumetric Flow 0-5 Vdc or 0-10Vdc 
or 4-20mA

Electrical Connections 8 Pin Mini-DIN
Supply Voltage 7 to 30 Vdc  (15-30Vdc for 4-20mA outputs)
Supply Current 0.035Amp  (+ output current on 4-20mA)

Mounting Attitude Sensitivity 0% Tare after installation
Warm-up Time < 1 Second

Wetted Materials2 303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Reinforced 
Nylon, Aluminum.

1. Volumetric meters only: Operating pressure limitations determined by Reynolds number thresholds. For 
operating pressures >10PSIG, please contact Application Assistance for more details.

2. If your application demands a different material, please contact Application Assistance for available options. 

The following specifications are for the standard configuration of the Alicat product as shipped from the 
factory. There are many low-cost customization options available.

Full Scale Flow
Mass Meter

Full Scale Flow
Volumetric Meter

Mechanical
Dimensions

Process
Connections1

Pressure Drop2 
(PSID)

0.5SCCM to 1SCCM 0.5CCM to1CCM 3.9”H x 2.4”W x 
1.1”D

M5 (10-32) Female 
Thread*

1.0
2SCCM to 50SCCM 2CCM to 50CCM 1.0
*Units ≤50SCCM F.S. are shipped with M5 (10-32) Male Buna-N O-ring face seal to 1/8” Female NPT fittings.

These adaptor fittings were selected for customer convenience in process connection. It should be noted that 
the 1/8” Female NPT introduces additional dead volume. To minimize dead volume, please see Accessories for 
the M5 Male to 1/8”OD compression fitting.

1. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter 
fittings.
2. Venting to atmosphere.  Lower Pressure Drops Available, please contact Application Assistance.

Mechanical Specifications

Technical Data for Micro-Flow and Ultra-Low Flow Mass & Volumetric Flow Meters
0 to 0.5SCCM Full Scale through 0 to 50SCCM Full Scale
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Dimensional Drawings: page 35, 36

Specification Mass
Meter

Volumetric
Meter Description

Accuracy ± (0.8% of Reading + 0.2% of Full Scale) At calibration conditions after tare

High Accuracy Option ± (0.4% of Reading + 0.2% of Full Scale) At calibration conditions after tare

Accuracy: Bi-directional 
Meters Only

± (0.8% of reading + 0.2% of total span 
positive full scale to negative full scale) At calibration conditions after tare

Repeatability ± 0.2% Full Scale
Operating Range 1% to 100% Full Scale Measure

Typical Response Time 10 Milliseconds (Adjustable)
Standard Conditions (STP) 25ºC & 14.696PSIA Not Applicable Mass Reference Conditions

Operating Temperature −10 to +50 ºCelsius
Zero Shift 0.02% Full Scale / ºCelsius / Atm

Span Shift 0.02% Full Scale / ºCelsius / Atm
Humidity Range 0 to 100% Non–Condensing

Measurable Flow Rate 128% Full Scale
Maximum Pressure 145 1451 PSIG

Output Signal Digital Mass, Volume,
Pressure & Temperature Volumetric Flow RS-232 Serial

Output Signal Analog Mass Flow Volumetric Flow 0-5Vdc 
Optional Output Signal 

Secondary Analog
Mass, Volumetric 

Pressure or Temperature Volumetric Flow 0-5 Vdc or 0-10Vdc 
or 4-20mA

Electrical Connections 8 Pin Mini-DIN
Supply Voltage 7 to 30 Vdc  (15-30Vdc for 4-20mA outputs)
Supply Current 0.035Amp  (+ output current on 4-20mA)

Mounting Attitude Sensitivity 0% Tare after installation
Warm-up Time < 1 Second

Wetted Materials2 303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Reinforced 
Nylon, Aluminum.

1. Volumetric meters only: Operating pressure limitations determined by Reynolds number thresholds. For 
operating pressures >10PSIG, please contact Application Assistance for more details.

2. If your application demands a different material, please contact Application Assistance for available options. 

The following specifications are for the standard configuration of the Alicat product as shipped from the 
factory. There are many low-cost customization options available.

Full Scale Flow
Mass Meter

Full Scale Flow
Volumetric Meter

Mechanical
Dimensions

Process
Connections1

Pressure Drop2 
(PSID)

100SCCM to 10SLPM 100CCM to 10LPM 4.1”H x 2.4”W x 1.1”D 1/8” NPT Female 1.0
20SLPM 20LPM 4.2”H x 2.4”W x 1.1”D 1/8” NPT Female 1.0

Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter 1. 
fittings.
Venting to atmosphere.  Lower Pressure Drops Available, please contact Application Assistance.2. 

Mechanical Specifications

Technical Data for Low Flow Mass & Volumetric Flow Meters
0 to 100 SCCM Full Scale through 0 to 20 SLPM Full Scale
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Dimensional Drawings: page 36, 37

Specification Mass
Meter

Volumetric
Meter Description

Accuracy ± (0.8% of Reading + 0.2% of Full Scale) At calibration conditions after tare

High Accuracy Option ± (0.4% of Reading + 0.2% of Full Scale) At calibration conditions after tare

Accuracy: Bi-directional 
Meters Only

± (0.8% of reading + 0.2% of total span 
positive full scale to negative full scale) At calibration conditions after tare

Repeatability ± 0.2% Full Scale
Operating Range 1% to 100% Full Scale Measure

Typical Response Time 10 Milliseconds (Adjustable)
Standard Conditions (STP) 25ºC & 14.696PSIA Not Applicable Mass Reference Conditions

Operating Temperature −10 to +50 ºCelsius
Zero Shift 0.02% Full Scale / ºCelsius / Atm

Span Shift 0.02% Full Scale / ºCelsius / Atm
Humidity Range 0 to 100% Non–Condensing

Measurable Flow Rate 128% Full Scale
Maximum Pressure 145 1451 PSIG

Output Signal Digital Mass, Volume,
Pressure & Temperature Volumetric Flow RS-232 Serial

Output Signal Analog Mass Flow Volumetric Flow 0-5Vdc 

Optional Output Signal 
Secondary Analog

Mass, Volumetric 
Pressure or 
Temperature

Volumetric Flow 0-5 Vdc or 0-10Vdc 
or 4-20mA

Electrical Connections 8 Pin Mini-DIN
Supply Voltage 7 to 30 Vdc  (15-30Vdc for 4-20mA outputs)
Supply Current 0.035Amp  (+ output current on 4-20mA)

Mounting Attitude Sensitivity 0% Tare after installation
Warm-up Time < 1 Second

Wetted Materials2 303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Reinforced 
Nylon, Aluminum.

1. Volumetric meters only: Operating pressure limitations determined by Reynolds number thresholds. For 
operating pressures >10PSIG, please contact Application Assistance for more details.

2. If your application demands a different material, please contact Application Assistance for available options. 

The following specifications are for the standard configuration of the Alicat product as shipped from the 
factory. There are many low-cost customization options available.

Full Scale Flow
Mass Meter

Full Scale Flow
Volumetric Meter

Mechanical
Dimensions

Process
Connections1

Pressure Drop2 
(PSID)

50SLPM 50LPM
4.4”H x 4.0”W x 1.1”D 1/4”  NPT Female

2.0
100SLPM 100LPM 2.5
250SLPM 250LPM 5.0”H x 4.0”W x 1.6”D 1/2”  NPT Female 4.0

1. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter 
fittings.
2. Venting to atmosphere.  Lower Pressure Drops Available, please contact Application Assistance.

Mechanical Specifications

Technical Data for Moderate Flow Mass & Volumetric Flow Meters
0 to 50 SLPM Full Scale through 0 to 250 SLPM Full Scale
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Dimensional Drawings: page 37

Specification Mass
Meter

Volumetric
Meter Description

Accuracy ± (0.8% of Reading + 0.2% of Full Scale) At calibration conditions after tare

High Accuracy Option ± (0.4% of Reading + 0.2% of Full Scale) At calibration conditions after tare

Accuracy: Bi-directional 
Meters Only

± (0.8% of reading + 0.2% of total span 
positive full scale to negative full scale) At calibration conditions after tare

Repeatability ± 0.2% Full Scale
Operating Range 1% to 100% Full Scale Measure

Typical Response Time 10 Milliseconds (Adjustable)
Standard Conditions (STP) 25ºC & 14.696PSIA Not Applicable Mass Reference Conditions

Operating Temperature −10 to +50 ºCelsius
Zero Shift 0.02% Full Scale / ºCelsius / Atm

Span Shift 0.02% Full Scale / ºCelsius / Atm
Humidity Range 0 to 100% Non–Condensing

Measurable Flow Rate 128% Full Scale
Maximum Pressure 145 1451 PSIG

Output Signal Digital Mass, Volume,
Pressure & Temperature Volumetric Flow RS-232 Serial

Output Signal Analog Mass Flow Volumetric Flow 0-5Vdc 

Optional Output Signal 
Secondary Analog

Mass, Volumetric 
Pressure or 
Temperature

Volumetric Flow 0-5 Vdc or 0-10Vdc 
or 4-20mA

Electrical Connections 8 Pin Mini-DIN
Supply Voltage 7 to 30 Vdc  (15-30Vdc for 4-20mA outputs)
Supply Current 0.035Amp  (+ output current on 4-20mA)

Mounting Attitude Sensitivity 0% Tare after installation
Warm-up Time < 1 Second

Wetted Materials2 303 & 302 Stainless Steel, Viton®, Silicone RTV (Rubber), Glass Reinforced 
Nylon, Aluminum.

1. Volumetric meters only: Operating pressure limitations determined by Reynolds number thresholds. For 
operating pressures >10PSIG, please contact Application Assistance for more details.

2. If your application demands a different material, please contact Application Assistance for available options. 

The following specifications are for the standard configuration of the Alicat product as shipped from the 
factory. There are many low-cost customization options available.

Full Scale Flow
Mass Meter

Full Scale Flow
Volumetric Meter

Mechanical
Dimensions

Process
Connections1

Pressure Drop2 
(PSID)

500SLPM 500LPM
5.0”H x 4.0”W x 1.6”D 3/4” NPT Female

4.0
1000SLPM 1000LPM 6.0
1500SLPM 1500LPM 9.0

1. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter 
fittings.
2. Venting to atmosphere.  Lower Pressure Drops Available, please contact Application Assistance.

Mechanical Specifications

Technical Data for High Flow Mass & Volumetric Flow Meters
0 to 500 SLPM Full Scale through 0 to 1500 SLPM Full Scale
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M & V Series:
0 – 0.5SCCM
0 – 1SCCM
0 – 2SCCM
0 – 5SCCM
0 – 10SCCM
0 – 20SCCM
0 – 50SCCM

M & V Series:
0 – 100SCCM
0 – 200SCCM
0 – 500SCCM

0 – 1SLPM
0 – 2SLPM
0 – 5SLPM
0 – 10SLPM
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M & V Series:
0 – 20SLPM

M & V Series:
0 – 50SLPM
0 – 100SLPM
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M & V Series:
0 – 250SLPM

M & V Series:
0 – 500SLPM
0 – 1000SLPM
0 – 1500SLPM
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Option: Totalizing Mode Screen

M and V Series Flow Meters and Controllers can be purchased with the Totalizing Mode option. This 
option adds an additional mode screen that displays the total flow (normally in the units of the main flow 
screen) that has passed through the meter or controller since the last time the totalizer was cleared. 
The Totalizing Mode screen shown below is accessed by pushing the “MODE” button until the label 
over it reads “Total”. If your meter is ordered with Totalizing Mode option, pushing the “Mode” button 
once will bring up the “Totalizing Mode” display.  Pushing “Mode” a second time will bring up the “Select 
Menu” display. Pushing it a third time will return you to the Main Mode Sreen.

 Hours    Mass    Clear
    0.3     0.00

           Mass
           SLtr
            Air

   
+0.0 SCCM

    Total

Counter – The counter can have as many as six digits. At the time of order, the customer must specify 
the resolution of the count. This directly affects the maximum count. For instance, if a resolution of 
1/100ths of a liter is specified on a meter which is totalizing in liters, the maximum count would be 
9999.99 liters. If the same unit were specified with a 1 liter resolution, the maximum count would be 
999999 liters.

Rollover – The customer can also specify at the time of order what the totalizer is to do when the 
maximum count is reached. The following options may be specified:

No Rollover – When the counter reaches the maximum count it stops counting until the counter is 
cleared.

Rollover – When the counter reaches the maximum count it automatically rolls over to zero and continues 
counting until the counter is cleared.
Rollover with Notification – When the counter reaches the maximum count it automatically rolls over to 
zero, displays an overflow error, and continues counting until the counter is cleared.

Hours.–.The display will show elapsed time since the last reset in 0.1 hour increments. The maximum 
measurable elapsed time is 6553.5 hours (about nine months). The hours count resets when the “clear” 
button is pushed, an RS-232 clear is executed or on loss of power

Clear – The counter can be reset to zero at any time by pushing the dynamically labeled “Clear” button 
located above the upper right side of the display. To clear the counter via RS-232, establish serial 
communication with the meter or controller as described in the RS-232 section of the manual.  To reset 
the counter, enter the following commands:

 In Streaming Mode:  $$T <Enter>

 In Polling (addressable) Mode:  Address$$T <Enter>      (e.g. B$$T <Enter>)
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Alicat Portable Meters and Gauges

Alicat Portable Flow Meters and Gauges use a common 9 Volt battery located in the top section of your 
meter. 
Output signals from the flow meter are passed through the female connector on top of the flow meter. 
Turn the switch on top of the flow meter “off” when the meter is not in use.
Normal (9V alkaline) battery life is approximately 8 hours (30-40 hours with a 9V-lithium battery), 
however many factors can affect this. 
Replace the battery as often as required. A yellow LED indicates low voltage and that the battery should 
be replaced. 
A false signal can result when the voltage drops below its normally regulated level. 
Alicat Portable Flow Meters and Gauges can also be powered by an optional AC/DC plug-in wall adaptor. 
With the adaptor plugged into the flow meter, the battery is bypassed and the meter will operate solely 
off the adaptor power supply.

Replacing the Battery:  
Remove the four Phillips head screws from the front cover and gently remove it as shown below.1. 
Remove the 9V battery, pulling the top of the battery out first.2. 
Disconnect the old battery from the harness and replace it with a new battery.3. 
Install the new battery bottom end first and replace the back cover so that the cushioning pad 4. 
presses directly down on the battery.
Replace the four Phillips head screws.5. 

Battery cover removal
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Option: Remote Electronics for High Line or Gas Temperatures
Some applications involve operating temperatures outside the standard Alicat device specifications. A 
solution using remote electronics is available. (This option is not applicable to liquid devices.)
The flow body’s components are minimized to only the required sensors. The flow data is sent to 
the microprocessor electronics up to 6 feet away from the sensor package. Relocating the sensitive 
electronics, including the LCD, allows for installation of the flow body in ambient temperatures as high 
as 85° Celsius with gas temperatures under 100°Celsius. 

In these applications we recommend our custom gauge calibration at a gas temperature of up to 
70°Celsius. This will reduce zero shift errors that occur when actual gas flow temperatures deviate 
substantially from the gas calibration temperature. This configuration is also used in integrations that 
require a compact flow package at the installation point.

Maximum distance 
between electronics 
and sensor package is 
6 feet.

Accessory: BB-9 Multi-Drop Box
The BB-9 Multi-Drop Box makes it convenient to wire multiple flow and/or pressure 
devices to a single RS-232 port. 
The Multi-Drop Box has nine 8 pin mini-DIN ports available. The ports are to be used 
with a standard double ended 8 pin mini-DIN (DC-62) style cable going from the box 
to each flow or pressure device. A single DB9 D-SUB type connector (COM PORT) 
connects, using the included cable, to the serial connector on a PC or laptop. 
All of the flow and/or pressure devices are powered via a terminal block on the front 
of the box. 

If more than nine devices will be required, additional Multi-Drop Boxes can be daisy chained together 
with a double ended 8 pin mini-DIN cable plugged into any receptacle on both boxes.

Accessory: RS-232 to RS-485 Converter
Since most computers have RS-232 communication onboard, Alicat has chosen RS-232 as the digital 
standard on all of its flow instruments. For those using RS-485 as their primary standard, our RS-232 
to RS-485 converter will allow interface between an RS-485 system and Alicat’s flow instrumentation.
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Accessory: Flow Vision™ SC Software
Flow Vision™ SC is an intuitive software interface to help 
your test cycles run smoother and shorten your engineering 
time! 

Flow Vision™ SC lets you connect to and communicate 
with multiple Alicat units simultaneously. Now you can view 
virtual displays, control tabs, charts and data lines from every 
connected Alicat device on the same screen.

Flow Vision™ SC supports all RS-232 Serial communication 
functions, including: gas selection, tareing, set-point control, 
valve tuning and flow averaging.

Session Saving: Save and reload your configuration data with confidence. 

Script Building: Create scripts to adjust a controller’s set-point value at variable specified time intervals.

Charting: Chart as many parameters as you want off as many devices as you want, with color coding, 
zooming, and printing functionality.

Alarms: Create software alarms that will notify you of given parameter conditions.

Data Capture & Logging: Capture and log data to either a .csv file or a .txt file. Improved Data Logging 
and Data Log File Splitting for easy to manage data.

Flow Vision™ SC supports multiple devices connected to 
the same RS-232 port.
Simply connect each device to a BB-9 Multi-Drop Box, 
then using device addressability, assign an identifier to each 
instrument.
Now you can easily monitor and control multiple Alicat 
instruments from your computer. 

Devices

Scripts

Data Logs

Charts

Terminals



42

Accessories
Part Number Description

FLOWVISIONSC Flow Vision™ SC software for interface with all Alicat instruments
BB-9 Multi-Drop Box
PCASE Industrial carry and storage case for portable meters/gauges
DC-61 8 Pin Male Mini-DIN connector cable, single ended, 6 foot length
DC-251 8 Pin Male Mini-DIN connector cable, single ended, 25 foot length
DC-301 8 Pin Male Mini-DIN connector cable, single ended, 30 foot length
DC-501 8 Pin Male Mini-DIN connector cable, single ended, 50 foot length
DC-751 8 Pin Male Mini-DIN connector cable, single ended, 70 foot length
DC-6RT 8 Pin Male Right Angle Mini-Din Cable, single ended, 6 foot length
DC-62 8 Pin Male Mini-DIN connector cable, double ended, 6 foot length
DC-252 8 Pin Male Mini-DIN connector cable, double ended, 25 foot length
DC-502 8 Pin Male Mini-DIN connector cable, double ended, 50 foot length
DC-602 8 Pin Male Mini-DIN connector cable, double ended, 60 foot length
MD8DB9 8 Pin Male Mini-DIN to DB9 Female Adapter, 6 foot length
IC10 Industrial cable, 6 Pin, single ended, 10 foot length
IC10-18G 18 gauge industrial cable, 6 Pin, single ended, 10 foot length
IC20 Industrial cable, 6 Pin, single ended, 20 foot length
IC24-18G 18 gauge industrial cable, 6 Pin, single ended, 24 foot length
IC50 Industrial cable, 6 Pin, single ended, 50 foot length
PVPS24U Universal 100-240 VAC to 24 Volt DC Power Supply Adapter
RS485-KIT RS-232 to RS-485 Converter
REMOTE Remote electronics with display
RD Remote Panel Mount Display

ALICAT DEVICE PROCESS CONNECTION
M5 (10-32) 1/8” 1/4” 1/2” 3/4”

COMPRESSION 
FITTING

1/8” SS-200-1-0157 SS-200-1-2 SS-200-1-4 SS-200-1-8
1/4” SS-400-1-0256 SS-400-1-2 SS-400-1-4 SS-400-1-8 SS-400-1-12
1/2” SS-810-1-2 SS-810-1-4 SS-810-1-8 SS-810-1-12
3/4” SS-1210-1-8 SS-1210-1-12

3mm SS-3M0-1-2 SS-3M0-1-4
4mm SS-4M0-1-2 SS-4M0-1-4
6mm SS-6M0-1-2 SS-6M0-1-4 SS-6M0-1-8
8mm SS-8M0-1-2 SS-8M0-1-4 SS-8M0-1-8

12mm SS-12M0-1-2 SS-12M0-1-4 SS-12M0-1-8 SS-12M0-1-12
16mm SS-16M0-1-8 SS-16M0-1-12

FILTER
10 micron 2F-F2L-10-B
20 micron CF-303-20-316
50 micron 2F-F2L-50-B 4F-F4L-50-B 8F-F8L-50-B 12F-F12L-50-B

Adapter 410133 Male M5 (10-32) Buna-N O-ring face seal to 1/8”Female NPT
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DB15 Pin-Out

Note: The above pin-out is correct for units with a DB15 pin-out. If your unit is 
marked DB15H or DB15K, you must use the correct pin-out (as shown on the 
following page).

Pin Number Function
2 Signal Out
5 Supply
8 Set-Point
9 Ground
11 Secondary Out
13 RS-232 Receive
15 RS-232 Send

8

1513119

2 5

DB15 Pin-Outs
If your Alicat Instrument was ordered with 

a DB15 connection, please be sure to 
reference the appropriate pin-out diagram.
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DB15H Pin-Out
Pin Number Function

6 Signal Out
7 Ground
11 Supply
14 Set-Point
10 Secondary Out
2 RS-232 Receive
15 RS-232 Send

7

11 14
1510

2 6

DB15K Pin-Out
Pin Number Function

2 Signal Out
5 Ground
7 Supply
8 Set-Point
9 Secondary Out
13 RS-232 Receive
14 RS-232 Send

7 8

14139

2 5

DB15 Pin-Outs
If your Alicat Instrument was ordered with 

a DB15 connection, please be sure to 
reference the appropriate pin-out diagram.

Note: The above pin-outs are correct for units with a DB15H or DB15K pin-out. 
If your unit is marked DB15, you must use the correct pin-out (see the previous 
page).



 Alicat Scientific 
Innovative Flow and Pressure Solutions 

 Alicat Digital Flow and Pressure Products: 

 See our full product line and 
complete technical specifications at: 

www.alicatscientific.com 

Ranges from 0.5SCCM to 1500SLPM ♦
Digital and Analog Communication ♦
Speed: 10 ms Response ♦
LCD with Push Button Interface ♦
Programmable Geometric Running Average ♦
Field Adjustable PID Loop Tuning ♦
30 Selectable Gases on One Meter ♦
Local and Remote Set Point Control  ♦
Multiple Analog Outputs available: Temperature,  ♦
Pressure or Flow
Tare: Automatic, Push Button or Remote ♦
Integrated Totalizer ♦
Mass Flow Controllers that also control absolute  ♦
pressure or volume flow

Mass and Volumetric Gas Meters 
 Ranges:   0-0.5SCCM to 0-1500SLPM
	 Response	Time:		 ≤10ms
 Accuracy:   ±(0.8% of reading ±0.02% of Full Scale)
Mass and Volumetric Gas Controllers 
 Ranges:   0-0.5SCCM to 0-1500SLPM
	 Response	Time:		 ≤100ms
 Accuracy:   (±0.8% of reading ±0.2% of Full Scale)

Precision Water Meters and Controllers 

Precision Pressure Gauges (gas & water)

Precision Digital Pressure Controllers (gas & water)

Dual Valve Pressure Controllers (gas media)



      Questions? Contact us at: 
 info@alicatscientific.com    

520-290-6060      888-290-6060 

 WE GLADLY PROVIDE EXPERT TECHNICAL 
SUPPORT FOR YOUR APPLICATIONS 

Alicat Scientific, Inc. was	 founded	 to	 produce	 laminar	 flow	 meters	 in	 a	
convenient design that simplify installation and use.

Today, Alicat products are used throughout the world in a broad range of applications. 
You	can	find	our	instruments	measuring	methane	emissions	at	farms,	controlling	weld	
gases in production facilities, providing data for atmospheric research at 30,000 feet 
and installed to provide pressure control on a prototype planetary rover.

Our engineers are highly skilled in a variety of disciplines (optics, astrophysics, 
metrology, materials and mechanical engineering) and possess extensive industry 
experience. They will work directly with you and your team before and after a product 
purchase to ensure successful results.

Whether your application is straightforward and clear, or complex and new, we can 
provide creative problem solving from a variety of perspectives and over a decade of 
in-house experience.

Special Application?  No Problem

Gas Mixtures  We can calibrate mixtures of up to 4 gases.

Customized Pressure Drops

Alternate Units of  Measure SCFM, SCFH, mmHG and more.

Vacuum Applications

Vacuum to Pressure Applications

Custom Connections

Dual Valve Pressure Controllers

Alternate STPs We may easily, calibrate to your Standardized 
Pressure and Temperature.

Bi-Directional Flow

Alarms Flow meters or pressure gauges can be ordered with an alarm 
based on any of the measured parameters.

And Much More!  Let us know what you need.


